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Scope
This manual describes how to install and operate the GDC TEAM 5520 software application
information contained in this manual has been carefully checked and is believed to be entire
reliable. However, as General DataComm improves the reliability, function, and design of th
products, is possible that information may not be current. Contact General DataComm if you
require updated information for this or any other General DataComm product.

General DataComm, Inc.
Technical Publications Department
Park Road Extension
Middlebury, Connecticut, USA 06762-1299
Tel:   1 203 758 1811 Toll Free:   1 800 794 8246

Manual Organization
The online (web-based) manual uses active areas which allow you to navigate through porti
the manual by clicking on any blue text.

This manual is divided into the following chapters: 

Chapter 1, Introduction

Chapter 2, Operations

Chapter 3, Configuration

Chapter 4, Maintenance

Chapter 5, Diagnostics

Chapter 6, NMS 520

Chapter 7, NMS 510
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 v
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Service Support and Training
VITAL Network Services, a General DataComm company, is committed to providing the serv
support and training needed to install, manage, and maintain your GDC equipment.  VITAL 
Network Services provides hands-on training courses through VITAL Network Services Global 
Technology Training Services. Courses range from basic data communications, modems an
multiplexers, to complex network and ATM systems. Training courses are available at our ce
in the US, UK, France, Singapore and Mexico, as well as at a customer’s site.

For more information on VITAL Network Services or for technical support assistance, conta
VITAL Network Services at:

VITAL Network Services World Headquarters
6 Rubber Avenue Telephones: Faxes:
Naugatuck, Connecticut 06770 USA 1 800 243 1030 1 203 723 5012

1 888 248 4825 1 203 729 7611
http//www.vitalnetsvc.com 1 203 729 2461

VITAL Network Services Regional Sales and Service Offices:

North American Region Office
6 Rubber Avenue
Naugatuck, Connecticut 06770 USA
Telephones: 1 800 243 1030

1 888 248 4825
1 203 729 2461
1 800 361 2552 (French Canadian)

Training: 1 203 729 2461
Faxes: 1 203 723 5012

1 203 729 7611

Central America, Latin America
VITAL Network Services
Periferico Sur 4225, Desp. 306
C.P. 14210, Mexico D.F., Mexico

Telephone: 52 5 645 2238
Training: 52 5 645 2238
Fax: 52 5 645 5976

Europe, Middle East, Africa
VITAL Network Services
Molly Millars Close
Molly Millars Lane
Wokingham, Berkshire RG41 2QF UK

Telephone: 44 1189 657200
Training: 44 1189 657240
Fax: 44 1189 657279

Asia Pacific
VITAL Network Services
501 Orchard Road 05-05
Wheelock Place, Singapore 238880

Telephone: 65 735 2123
Training: 65 735 2123
Fax: 65 735 6889
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Chapter 1:  Introduction

Overview
This manual describes the General DataComm TEAM 5520 Unix Application for HP OpenV
You should be familiar with HP OpenView and with the operation of digital data service unit
(DSUs) in order to use this manual effectively. 

The TEAM 5520 Unix Application, which runs on either a Sun workstation or an HP platform,
collection of integrated applications for the HP OpenView Network Management Platform. T
applications use the Simple Network Management Protocol (SNMP) to manage GDC SC 552
Set Emulator (DSE) cards, which are part of a SpectraComm 5000 (SC 5000) system. 

The TEAM 5520 applications allow you to: 

• Configure SC 5520 DSEs

• Configure NMS 510/520 DSUs, SC 521A DSUs, SC 521A/S DSUs installed as remote u
communicating with the SC 5520 DSE

• Monitor the operation of the above DSEs and DSUs via a display of the unit’s Front Panel 
LED indicators, and through detailed Alarms and DTE Interface status displays. 

• Diagnose suspected problems using local and remote loops (with or without an internall
generated test pattern). 

Note For information on SC 5520 operation with the NMS DSUs, refer to Chapter 6, NMS 520  and to Chap
NMS 510 . For information on SC 5520 operation with the SC 521A or the SC521A/S, refer to the TEAM
manual and its related release notes.
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 1-1
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SC 5000 System Overview

SC 5000 hardware consists of three types of components: a Data Set Emulator (DSE), a Lin
Terminating Unit (LTU), and a SpectraComm Manager Card (SCM), described below.

Data Set Emulator (DSE) 

The DSE performs DTE interface functions in a manner that emulates the operation of a trad
data set directly connected to a telephone line. For example, the SC 5520 DSE appears to 
and to its remote DSU to be a DATAPHONE Digital Service (DDS) DSU. Rather than being
connected directly to a Telco line, however, the SC 5520 DSE transmits and receives data t
a data highway incorporated in the backplane of the SpectraComm shelf. The data highway
the DSE to an LTU. 

Line Terminating Unit (LTU) 

The LTU performs network interface and channel grooming functions for a group of DSEs. A
5001 LTU connects to a T1 line and an SC 5002 LTU connects to a E1 line. Each transmits
combined data traffic of its group of DSEs to a Telco switching site. A T1 line provides 24 D
for that purpose; an E1 line provides 30 DS0s for data, with two others used for network sign
and framing. On the line, data for each DSE occupies one or more DS0s. Telco switching equ
routes the DS0s to their individual remote destinations. In this way a single connection betwe
SC 5000 site and a Telco switching site can support connections with multiple remote sites,
24 with a T1 line or up to 30 with an E1 line depending on how many DS0s each DSE requir
a DDS device, an SC 5520 DSE can employs one DS0. Each type of LTU is managed by it
TEAM application. 

SpectraComm Manager (SCM)

The SCM acts as the SNMP agent through which TEAM management applications commun
with SC 5000 components. All management communications are directed to the SCM card In
Protocol (IP) address. The SCM card relays commands and responses between manageme
applications and hardware components, using a slot addressing scheme to communicate ov
SpectraComm shelf backplane with the other SC 5000 components. The SCM is transparen
applications, which operate as though they were communicating directly with the hardware 
The SCM card is managed by the TEAM Core application, which is also responsible for the
Discovery and Mapping functions by which HP OpenView keeps track of the devices being 
managed. 

SC 5520 DSE

An SC 5520 DSE performs the DTE interface functions of a DDS DSU. It can transmit to an
receive from other DDS-compatible equipment. It can support remote management of GDC
520, NMS 510, SC 521A and SC521A/S. 
1-2 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 058R727-V400
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TEAM 5520 Applications
The applications that make up the TEAM 5520 manager are grouped on menus under the he
Performance, Configuration, Fault, and Misc (Miscellaneous). Menus for the applications ar
available in two ways: 

• From the menu bar of the Shelf Map window when an SC 5520 DSE is selected in the wi

• From the Select button on the SC 5520 Front Panel display 

SC 5520 Front Panel displays current status information on the SC 5520 DSE by displaying
states of the LED indicators on the front panel of the unit; provides Select button menus by 
you can invoke all other functions of the TEAM 5520 manager. Front Panel is a selection on
Performance menu in the Shelf Map window menu bar. You can also launch the Front Panel d
from that window by double clicking on the shelf icon of the DSE you need to work with.

The following TEAM 5520 applications appear on both the Map window and Select button m

• Performance: 

Alarm Detail – furnishes detailed information about alarm state changes

DTE Status – displays information on the status of signals in the DTE interface 

• Configuration:

Configure – enables you to configure a selected SC 5520 DSE 

Maintenance – enables you to set device specific attributes that are not set as configura
options

• Fault:

Diagnose – enables you to run diagnostic tests on a selected SC 5520 DSE

The Misc menu in the Map window menu bar contains three selections that do not appear in
Front Panel Select button menu: 

Information – displays revision level information on the TEAM SC 5520 software; can als
accessed by clicking on the GDC logo in the Front Panel display. 

Front Panel Poll Rate – enables you to set a default polling interval to be in effect each tim
Front Panel display is opened 

Note Pad – opens a shell tool on the workstation running the TEAM software. You can us
shell tool to run a text editor, mail tool, or any other software that resides on the worksta
The Note Pad application provides this access for keeping records on the system. 
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 1-3
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Chapter 2: Operations

Overview
The TEAM 5520 controller application consists of a group of smaller applications, each devo
a specific aspect of controlling or monitoring the SC 5520 Data Set Emulator. There are two m
of access to the TEAM 5520 applications: the shelf map menu bar, and the Front Panel win
Select button menus. This chapter describes both. 

There are two applications in the Performance category: Alarms displays alarm information 
read-only window; DTE Status displays the status of signals in the DTE interface. This chapte
describes both applications. 

There are two applications in the Configuration category: Configure and Maintenance. Each
supports read/write windows by which you can review and alter DSE operating parameters.
chapter describes how to access the Configuration and Maintenance applications. Instructio
using the two applications appear in subsequent, individual chapters. 

The Diagnostic application supports a read/write window by which you can command the te
functions of the DSE and view test results. This chapter describes how to access the Diagn
application. Instructions for using the application appear in a subsequent chapter. 

Three items appear on the Shelf Map menu bar as Misc (miscellaneous): Information, which
displays version and copyright information on the TEAM 5520 application software; Front P
Poll Rate, which affects the Front Panel display; and Note Pad. This chapter describes all th
None of these three items appear in the Front Panel Select button menu. Information can b
accessed from the Front Panel by clicking the mouse on the GDC logo in that display. 
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 2-1
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Map Window Menu Bar Access

The table on the following page illustrates how the TEAM 5520 application functions are arra
on the menu bar at the top of the Shelf Map window. The table shows only the menu selectio
the TEAM 5520 applications. The map window menus include selections in addition to thos
apply to TEAM 5520 because the window also provides access to other applications. 

You must select the DSE you intend to work with before you open the menu you intend to u
Select the DSE by clicking the mouse once on its icon in the shelf map

.

The Performance menu Front Panel selection opens the Front Panel display window. The S
button menus in the Front Panel display window include the selections that appear above, w
exceptions of Front Panel under Performance and the Misc category. 

Common Window Features

Each TEAM 5520 application you select opens an on-screen window in which to operate. A nu
of features are common to many of the windows: 

Triangle button – in the title bar; reduces the window to an icon when you click on it. Doub
clicking on icon restores the window. This button appears on the top leve
window for each application.

Title bar – identifies the specific TEAM 5520 application running in the window; for 
example TEAM 5520 Main Configuration or TEAM 5520 Diagnostics 

Menu bar – contains the File and Help menus. File menu contains the Exit command
to dismiss the window as well as commands specific to the window. Som
windows have additional Menu bar selections. 

The Menu bar appears on the top level window for each application. A M
bar appears in the Main Configuration window, for example, but not in the
windows you access from Main Configuration.

Name field – identifies the SC 5520 the application is currently connected to by displa
the user-configured shelf name, followed by the DSE slot number, and th
user-configured device name. 

Descriptions in this manual of the individual TEAM 5520 applications identify window featur
that are specific to the applications, such as selections in the Menu bar and menus, and but

Menu Bar Menu Selections

Performance Front Panel

Alarm Detail...

DTE Status...

Configuration Configure...

Maintenance...

Fault Diagnose...

Misc Information...

Front Panel Poll Rate...

Note Pad
2-2 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 058R727-V400
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SC 5520 DSE Front Panel

The SC 5520 Front Panel display window, show below, provides a graphical interface to a se
SC 5520 DSE. From the Shelf Map window you can launch a Front Panel two ways:

• select the unit you intend to work with, then select Front Panel from the Performance me
the Shelf Map window menu bar 

• double click the mouse on the slot icon for the unit you intend to work with. 

The application responds by displaying a window that depicts the front panel of the SC 5520
unit. The LEDs shown in the display reflect the states of the actual indicators on the physica

INS – In Service

ON – Power On

SD – Send Data indicates when lit that the DSE is transmitting data

RD – Receive Data indicates when lit that the DSE is receiving data fr
the remote DSU

RS – Request To Send indicates when lit that the DTE has data to tra

CO – Carrier On indicates when lit that the DSE is receiving a signal

TMG – Timing is lit when the DSE is designated as the 8 kHz clock sou
for its shelf

RSP – NMS Response

TM – Test Mode, is lit red while the DSE performs a diagnostic test 

ALM – Alarm, indicates by its color, which matches that of the SC 552
Shelf submap icon for the unit, that the DSE has detected an alarm 
condition. 

ST – Self Test is lit while the internal test pattern generator/checker is
active. 

LT – Local Test is lit while the DSE is in the Local Loopback test conditio

RL – Remote Loop is lit while the DSE is performing a remote loopbac
test with the remote DSU. 

DL – Digital Loop is lit while the DSE is performing a digital loopback t
direct data back to the remote DSU. 

The Front Panel screen displays the current operating speed of the D

The application polls the DSE to keep the states of the LEDs in the Fr
Panel display current. The time of the most recent poll appears at the 
bottom of the Front Panel display, to the left of the Help button. The tim
is displayed in white when Auto Poll is enabled, and in yellow when it 
disabled. 

The Select button, at the bottom of the Front Panel displays provides ac
to menus for the rest of the TEAM 5520 application functions. The 
following table shows the arrangement of the Select button menus. It dif
somewhat from the arrangement on the Map window menu bar. 
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 2-3
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The two Poll selections in the Select button menu determine when the application collects n
information from the DSE to update the Front Panel window: 

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Front Panel window displays a static snapshot of the L
states as they were at the last poll, either when the window was launched or a subseque
Demand Poll. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Select Menu Items Second Level Selections

Performance Alarm Detail...

DTE Status...

Configuration Configure...

Maintenance...

Fault Diagnose...

Demand Poll

Auto Poll (*) 15 seconds

30 seconds

60 seconds

Disable

Exit * Displays Off or poll interval
2-4 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 058R727-V400
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Alarms Application
You can launch the TEAM 5520 Alarm application from the Shelf Map Performance Menu or 
the front panel menu. The application displays the read-only Alarm Detail window for the sele
DSE (See Figure 2-1).

The TEAM 5520 application gets alarm indications from the DSE in two ways: 

• By receiving traps that the SCM sends automatically in response to alarm conditions at th

• By polling the SCM for changes in alarm conditions at the DSE.

The Alarm Detail window displays alarms grouped into three 
categories: 

• Major

• Minor 

• Informational

Figure 2-1 Alarm Detail Window
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 2-5
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Major Alarms

EEPROM Checksum – indicates that the non-volatile memory that stores the DSE configura
has become corrupted

DTP Loss – indicates loss of power at the DTE

DCD Loss – indicates loss of incoming signal

DCD Shorted – indicates Data Carrier Detect is shorted to ground or to another output

CTS Shorted – indicates Clear To Send is shorted to ground or to another output

RXD Shorted – indicates Receive Data is shorted to ground or to another output

RXC Shorted – indicates Receive Clock is shorted to ground or to another output

TXC Shorted – indicates Transmit Clock is shorted to ground or to another output

Minor Alarms

RXD Loss – indicates loss of Receive Data 

TM Shorted – indicates Test Mode signal is shorted to ground or to another output

DSR Shorted – indicates Data Set Ready is shorted to ground or to another output

Informational Alarms

Front Panel Test – indicates the DSE has been commanded into a test by means of its fron
switches 

DSR Loss – indicates the DSE is not outputting Data Set Ready to the DTE 

DTR Loss – indicates the DSE is not receiving Data Terminal Ready from the DTE 

TXD Loss – indicates loss of Transmit Data 

STC Loopback – indicates the DSE has been commanded into a test by the Telco Serving T
Center (STC) 

Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains only the selection Exit, by which you can dismiss the window. 

The View menu consists of three selections: Major, Minor, and Informational, each with a ch
box beside it. To remove an alarm category from the window display, click on its check box s
it is unchecked. Clicking a box so that it is checked restores the corresponding category to t
display. 
2-6 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 058R727-V400
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DTE Status Application
You can launch the TEAM 5520 DTE Status application from the Shelf Map Performance Me
from the front panel menu. The application displays the read-only Status window for the sel
DSE (See Figure 2-2). The window displays indicators for the states of the EIA signals at the D
interface. Dark green indicates Off, light green indicates On, and light green with a superimp
two-headed arrow indicates transitions. 

Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto Po
Exit. 

Selecting Demand Poll causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Status window displays a static snapshot of the EIA indicat
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

Figure 2-2 DTE Status Window
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 2-7
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Configuration Application
You can launch the TEAM 5520 Configuration application from the Shelf Map Configuration
Menu or from the front panel menu. 

When you launch the application, it initially displays the read-only TEAM 5520 Configuration
window, which has a File menu and a Navigate menu in its menu bar. 

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating configur

• Save to Unit, which puts the new configuration into use by the DSE 

• Load Template, by which you can recall a stored configuration template that you can then
to the DSE either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstation f
future use as a template 

• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template 

• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the read/write windows by which you can config
various aspects of DSE operation: 

• System Options

• Network Options

• DTE Options

• Diagnostic Options

• Alarms Reported

• Add Remotes

The TEAM 5520 Configuration application is fully described in Chapter 3, Configuration. 
2-8 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 058R727-V400
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Maintenance Application

You can launch the TEAM 5520 Maintenance application from the Shelf Map Configuration M
or from the front panel menu. 

The application displays one read/write window by which you can control some aspects of D
operation that fall outside the scope of the Configure application. The TEAM 5520 Maintena
application is fully described in Chapter 4, Maintenance. 

Diagnostics

You can launch the TEAM 5520 Diagnostics application from the Shelf Map Fault Menu or f
the Front Panel display Select button menu. 

The application displays one read/write window by which you can control a variety of test func
on the DSE. The TEAM 5520 Diagnostics application is fully described in Chapter 5, Diagnostics. 

Miscellaneous Functions

Information

You can launch the TEAM 5520 Information window from the Shelf Map Misc menu or by dou
clicking on the GDC logo in the Front Panel display. 

Information displays a read-only window that contains the name of the application, software
revision level information, and copyright information. The File menu in the menu bar contains
the selection Exit, by which you can dismiss the window. 

Note Pad

You can launch the Note Pad application from the Shelf Map Misc Menu. The application op
text editor for keeping records on the system. 

Front Panel Poll Rate

You can open the Front Panel Poll Rate window (See Figure 2-3) from the Shelf Map Misc Menu. 
The setting you select in this window determines the initial polling rate for Front Panel displa
each time they are opened. The rate selection is a global function. It selects initial polling ra
all front panel displays linked to a TEAM Core application, regardless of which individual 
application you access it from. 

There are four selections, each accompanied by a checkbox: 

Slow 

Normal 

Fast 

Demand Poll Only 
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 2-9
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Front Panel Poll Rate Procedure

To set the desired polling rate, first click on the appropriate checkbox and then select Save 
from the File menu. The precise polling frequency that results from a setting of Slow, Norma
Fast depends on a number of factors. The higher the rate, the more communication and pro
capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a se
by means of the Auto Poll selection in the Select button menu. Changes you make with that
selection are not retained when the display is closed. 

To dismiss the window, select Exit from the File menu. 

Figure 2-3 Front Panel Poll Rate Window
2-10 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 058R727-V400
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Chapter 3: Configuration

Configuration Overview
The TEAM 5520 Configuration application enables you to set all the options in the SC 5520
Set Emulator through a convenient group of configuration windows. 

You can start the TEAM 5520 Configuration application by either of two methods: 

• Select a DSE symbol on the Shelf Map, then select the Configure option from the Configu
menu. 

• Click on the Select button of the Front Panel display, then click on Configuration and se
Configure from the resulting menu. 

Templates

You can store configuration settings as templates on the workstation that runs the TEAM 55
application. A template stores a configuration for the DSE options, and you can store as ma
templates as you need. 

To load configuration settings from a template into the DSE you must perform the following s

1. Select Load Template from the File menu and select the template from the resulting dia
window. The application retrieves the configuration settings of the selected template. 

2. Select Save to Unit from the File menu. The application makes the template configuratio
settings the current operating configuration for the DSE. 

Configuration Procedure

The following steps describe how to use the configuration application, and illustrate the func
of the Main Configuration window menus. 

1. Access the Main Configuration window, either from the Shelf Map or from the Front Pan
display. The application reads the current Main configuration from the DSE when you op
the Main window. 

You can select to base your configuration changes on either the current configuration or a
configuration template. In either case, the DSE continues to operate using its unchanged 
configuration. 

The Refresh selection on the Main window File menu causes the application to read the curre
configuration from the DSE. All changes to all configuration windows that have not previo
been saved to a profile or a template are lost when you select Refresh. 

2. To edit the current configuration of the DSE, proceed directly to the Navigate menu as 
described below. To edit a template, select Load Template from the File menu and select a 
template from the resulting list. 
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 3-1
Issue 1 Operation Manual



Configuration

he 

or an 
n the 
lays 

until 
menu, 

alues 

by 
dow 

f your 

ent 

ates 

ed 
her 

ining 
til the 
 value 
3. Click on the Navigate button to display a menu of the configuration windows, and select t
one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the input field f
option, a window opens to display all the values the field can be set to. Click the mouse o
value you select. When you change the value or setting of an option, the application disp
the option name and the new value in white, rather than black, type. They remain white 
you either save the changes to the DSE or a template by means of the Main window File 
or restore the option to its last stored value or setting. 

You can discard changes to a configuration window and return all its fields to their stored v
in two ways:

• Click on the Reset button to discard changes while keeping the window open

• Click on the Cancel button to discard changes and close the window. 

You can close a configuration window without losing changes by clicking on the OK button.

You can keep multiple configuration windows open on-screen and move between them 
clicking the mouse on the one in which you intend to operate. The Main Configuration win
remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made all o
changes, click on the File menu button of the Main Configuration window. From that menu 
you can select Save to Unit to save the new configuration in the DSE, or select Save to 
Template to save it as a template in the workstation. 

6. When you select Save to Unit, the changed configuration for the DSE becomes the curr
configuration. 

7. When you select Save to Template, a window appears containing a list of existing templ
and a field for entering a new template name. You can select an existing template to be 
overwritten with the new configuration, or enter a name to create a new template. A stor
template is available to be loaded by the application and then saved, with or without furt
modification, to any SC 5520 DSE. 

Configuration Option Values

When you click the mouse on the entry field for a configuration item, a window opens conta
all the values that are permitted for that configuration item. Hold down the mouse button un
highlight is on the value you intend to configure, then release the button. The newly selected
appears in the entry field for the configuration item. 
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The Main Configuration window displays the following read-only items:

Name: displays shelf and slot identification for the DSE 

Slot State: displays Active or Inactive

Operational Status: displays Up or Down

Serial Number: displays the serial number of the DSE

Firmware Revision: displays the revision level of the DSE operating code

DDS MIB Version: displays the revision level of the MIB files that enable SNMP control 

5520 MIB Version: displays the revision level of the MIB files that enable SNMP control 

The TEAM 5520 application relies on the SCM and SC 5520 DSE to indicate when a configur
problem has caused an SNMP set error. 

Figure 3-1 Main Configuration Window
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 3-3
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Main Configuration Menus

The Main Configuration window title bar displays the application name, TEAM 5520 
Configuration. The main body of the window contains read-only items that identify the DSE 
provide information about its operations.

The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the DSE. From the Navigate menu you 
select the individual configuration windows in which you make changes. The File menu commands 
the storage and retrieval of configuration settings. The contents of the two menus appear be

 

Menu Buttons Menu Selections
Further 

Selections

File Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate System Options... 

Network Options...

DTE Options... 

Diagnostic Options...

Alarms Reported... 

Add Remotes...

All Screens... 
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System Options

The System Options configuration window contains three configuration options and one read
display field. 

Figure 3-2 System Options Configuration Window

Alarm Scan – permits you to enable or inhibit (disable) the alarm scan. 

Options:

Enable 

Inhibit 

Front Panel – permits you to disable the switches on the front panel of the DSE as protectio
against any inadvertent interruption of its operation. 

Options:

Enable – DSE front panel switches are operational. 

Inhibit – DSE front panel switches are disabled. 

Rsp Timeout – selects the length of time the SCM waits for a response from the unit before 
declares a No Response condition. 

Options:

2, 4, 6, 8 seconds

Data Highway – read only field that identifies the backplane data highway the DSE is using 
exchange data with its LTU. The selection is made by the Shelf Configuration application
is part of the TEAM Core software. 

Options:

One

Two 

Three

Four
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 3-5
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Network Interface

The Network Interface configuration window contains two groups of options grouped under 
headings Network Parameters and Circuit Parameters. 

Figure 3-3 Network Options Configuration Window
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Network Parameters

Circuit Type  – selects the type of circuit over which the DSE communicates with its remote un

Options:

Pt to Pt - Clear Channel – specifies a point-to-point 64 kbps circuit; when this is selected t
Data Rate option is forced to this value and cannot be changed 

Pt to Pt - DDS-I – specifies a point-to-point DDS-I circuit at any Data Rate up to 56 kbps 

Pt to Pt - DDS-SC – specifies a point-to-point DDS-SC circuit at any Data Rate up to 56 k

Multipoint - DDS-I – specifies a multi-point DDS-I circuit at any Data Rate up to 56 kbps 

Multipoint - DDS-SC – specifies a multi-point DDS-SC circuit at any Data Rate up to 56 kb

Carrier  – selects the combination of transmit and receive carrier modes (constant/switched)
used by the DSE. 

Options:

Tx Constant, Rx Constant – for use on a point-to-point circuit 

Tx Constant, Rx Switched – for use when the DSE is the master unit on a multi-point circui

Tx Switched, Rx Constant – for use when the DSE is a remote unit on a multi-point circuit 

Tx Switched, Rx Switched – for use when required by specialized applications

Data Rate – selects the data rate and mode (synchronous/asynchronous) to be used by the

Options:

2.4 Kbps - Async 

2.4 Kbps - Sync 

4.8 Kbps - Async 

4.8 Kbps - Sync 

9.6 Kbps - Async 

9.6 Kbps - Sync 

19.2 Kbps - Async 

19.2 Kbps - Sync 

56 Kbps - Sync 

64 Kbps - Sync – this value is displayed when the Data Rate option is forced by selection 
to Pt - Clear Channel in the Circuit Type option 
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 3-7
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Circuit Parameters

Tx Clock Source – selects the source of transmit timing for the DSE.

Options:

Receive – selects transmit timing based on receive data timing

Internal – selects transmit timing provided by the DSE internal clock 

External – selects transmit timing provided by the DTE; the Buffer Clock option is forced
External and cannot be changed when this is selected 

Buffer Clock – selects the source of timing for the buffer between the DSE and its DTE. 

Options:

Internal – selects timing provided by the DSE internal clock 

External – selects timing provided by the DTE; when External is selected for Tx Clock So
this selection is forced and cannot be changed 

Zero Encoding – selects Zero Encoding. This feature can be used in point-to-point 56 kbps D
SC applications to enable the DTE to transmit all spaces (zeros) without violating the ones d
requirements of DDS. Zero Encoding is a GDC proprietary feature, and can only be used w
communicating with a compatible GDC DSU. The feature must be enabled at both units. 

Options:

Enable – DSE prevents the all space condition at the expense of reduced secondary cha
bandwidth 

Disable – DSE does not prevent the all space condition 

Remote Unit Type – specifies the type of remote DSU (NMS 520 or NMS 510) with which th
DSE is to be used. This option is only available to be set when the Circuit Type option in the
Network Options configuration window is selected as Multipoint and no remote units have yet
added by the Add Remote application. In all other circumstances the function of this option 
overridden and the option is grayed out. 

Options:

NMS 520 or SC521A in 520 mode – when the remote DSUs are specified to be NMS 520  o
SC521A units in 520 mode, the options Sentry Timer and Rmt Rsp Interval are available
configuration. 

NMS 510 or SC521A in 510 mode – when the remote DSUs are specified to be NMS 510 o
SC521A units in 510 mode the options Sentry Timer and Rmt Rsp Interval are grayed o
3-8 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 058R727-V400
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Sentry Timer – selects the minimum time interval permitted between alarm reports from a re
NMS 520 DSU in a point-to-point link. This option is grayed out when a multipoint Circuit Typ
selected. 

Options:

5 Minutes to 125 Minutes – in five minute increments 

Rmt Rsp Interval – selects the minimum time interval permitted between alarm reports from
remote NMS 520 DSU in a multi-point link. This option is grayed out when a point-to-point Cir
Type is selected. 

Options:

Disable 

10 Seconds to 120 Seconds – in ten second increments 

Circuit Assurance – when this option is enabled the DSE clamps Clear To Send when it det
any of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or 
Inactive Channel Code. 

Options:

Disable 

Enable 

System Status – when this option is enabled the DSE clamps Data Set Ready when it detect
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or 
Inactive Channel Code. 

Options:

Disable 

Enable 

Note All remote units on a multi-point link must be set for the same Remote Response Interval value.
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 3-9
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The DTE Options configuration window contains three groups of options under the heading
Interface Parameters, Control Parameters, and Async Parameters. 

Figure 3-4 DTE Interface Configuration Window

Interface Parameters

Interface Type – specifies the DTE port type. 

Options:

RS232 – EIA/TIA-232-E interface 

V.35 – ITU-T V.35 interface 

Auto – the DSE automatically senses the interface type being used by the DTE 

Interface Adapter – read-only field displays whether or not the DSE has a Data Rate Adapte
(DRA) card installed. 

Options:

None 

Installed 
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Control Parameters

AAS – selects whether or not the DSE provides Automatic Anti-Streaming protection, and the
limit it enforces when the feature is enabled. This option is only valid and available to be confi
when the Circuit Type option in the Network Options configuration window is set to Multipoin

Options: 

Disable

5 Seconds

10 Seconds

30 Seconds

45 Seconds

Constant DSR – selects the DSE to output a constant or switched Data Set Ready signal to its

Options: 

Disable – switched DSR signal controlled by DTR 

Enable – constant DSR signal

CTS Delay – selects the delay (if any) between the DSE receiving Request To Send from the
and returning Clear To Send to the DTE. This option is forced to CTS On and grayed out wh
Constant Tx Carrier is selected in the Carrier option of the Network Options window. 

Options: 

CTS ON – no delay; grayed out when a multi-point link is selected as the Circuit Type 

Fixed 3 Char – equivalent to three character times 

0 msec 

30 msec 

60 msec 

90 msec 

HDLC Invert – selects whether or not the DSE uses inverted channel data from the DTE. D
inversion is used primarily with DDS-SC 56 kbps circuits, to enhance data quality in a networ
does not provide B8ZS coding. 

Options: 

Disable – normal data 

Enable – inverted data

CAUTION 
When changing the setting of this option, set only this option and save the change to the unit. Do
combine it with any other configuration changes. 

The option must be set the same at both ends of the link. 

You must make changes at the remote DSU first, before you change the option setting at the DS

Changing the option at the remote causes loss of communication between the remote and maste
until you change the option setting at the master. 
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 3-11
Issue 1 Operation Manual



Configuration

 the 

 stop 

 DSE 
op bits. 

f Text 

it from 

at the 

nd of 

nd of 

cuit. 
d for 
Async Parameters

The Async Parameters options are grayed out when a synchronous Data Rate is selected in
Network Interface configuration. 

Character Size – selects the number of bits per asynchronous character, including start and
bits. 

Options: 

11 Bits 

10 Bits 

9 Bits 

8 Bits 

Over Speed – selects the percentage above its configured normal operating rate at which the
can accommodate receive data. It performs the over speed compensation by shaving st

Options: 

1%

2.3%

Suppression – determines what actions the DSE takes concerning transmit and receive End o
(EOT). 

Options: 

Disable – the DSE does not insert EOT at the end of transmissions, and does not delete 
the end of received signals 

Rx EOT – the DSE deletes EOT from the end of received signals; it does not insert EOT 
end of transmissions 

Tx EOT – the DSE inserts EOT at the end of transmissions; it does not delete it from the e
received signals 

Rx + Tx EOT – the DSE inserts EOT at the end of transmissions, and deletes it from the e
received signals 

Rate Adaption – specifies the DTE interface operating rate when it is below that of the DDS cir
This option is only valid when the Data Rate option in the Network Options window is selecte
2.4 Kbps - Async; it is grayed out when any other rate is selected. 

Options: 

Disable 

1200 

600 

1800 to 2400 
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Diagnostic Options

The Diagnostic Options configuration window contains two groups of options under the hea
DTE Equipment and Network Parameters. 

Figure 3-5 Diagnostic Options Configuration Window

DTE Equipment

Line Loopback Control – selects whether or not the DTE can command the DSE into a Line
Loopback (local) test by means of a signal at the interface port on EIA pin 18. 

Options:

Enable 

Disable 

Remote Loopback Control – selects whether or not the DTE can command the DSE into a Rem
Loopback test by means of a signal at the interface port on EIA pin 21. 

Options:

Enable 

Disable 

Data Set Ready – selects how the DSE controls the DSR output to the DTE during local loopb
(LT) test modes. 

Options:
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 3-13
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Off During LT Test 

Normal – DSR operates in the same way that it is optioned to function during data mode
operations 

Network Parameters

Line Loopback Test Points – selects whether a Line Loopback command causes the DSE on
loop transmit data back to the DTE, or also to loop receive data back to the network. 

Options: 

Network & DTE – Line Loopback command causes DSE to loop data in both directions

DTE Only – Line Loopback command causes DSE to loop data back to DTE only 

Telco Latching Loopback Response – selects whether or not the DSE accepts the latching-ty
DSU Loopback command code from a Telco Serving Test Center (STC). The latching-type 
command code places the unit into the test condition, which continues until a second comman
is sent by the STC. 

The DSE always accepts the non-latching DSU loopback command code, which places the 
the test condition only as long as the code continues to be received. 

Options: 

Enable – DSE accepts latching-type DSU Loopback command code

Disable – DSE does not accept latching-type DSU Loopback command code

Customer RDL Response – selects whether or not the DSE accepts a remote loopback comm
from its remote DSU. 

Options: 

Enable – the DSE accepts the remote loopback command selected by the RDL Initiation
Sequence option

Disable – the DSE does not accept a remote loopback command 

RDL Auto Timeout  – selects whether or not the DSE ends remote digital loop automatically b
on a timeout. This option is grayed out when Customer RDL Response is set to Disable. 

Options: 

10 Minutes – DSE terminates remote digital loop after ten minutes without need for furthe
operator action. You can end the test manually before the timeout. 

Disable – remote digital loop continues until terminated by operator action.

RDL initiation Sequence – selects the remote loopback command the DSE accepts from its re
DSU. This option is grayed out when Customer RDL Response is set to Disable. 

Options: 

V.54 

PN 127 
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Alarms Reported

The Alarms Reported configuration window (Figure 3-6) lets you configure which alarm 
conditions are to be reported for the DSE and which are not.

Figure 3-6 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection
located to its left. You can select or de-select individual alarm options by simply clicking the m
button on the appropriate selection fields. When an option is selected for its alarm to be rep
its selection field is highlighted. The selection fields next to alarm options that are not to be rep
are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option fie
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection fields. 

After clicking Report All or Report None you can then change the state of individual fields as
needed. 

Alarm Options – DTE

DTP Loss – alarm indicating loss of Data Terminal Power 

DCD Loss – alarm indicating loss of Data Carrier Detect 

DSR Loss – alarm indicating loss of Data Set Ready 

DTR Loss – alarm indicating loss of Data Terminal Ready 

RxD Loss – alarm indicating no receive data from the remote DSU 

TxD Loss – alarm indicating no transmit data from the DTE 
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TM Shorted – alarm indicating a short circuit on the Test Mode interface lead 

DCD Shorted – alarm indicating a short circuit on the Data Carrier Detect interface lead 

DSR Shorted – alarm indicating a short circuit on the Data Set Ready interface lead 

CTS Shorted – alarm indicating a short circuit on the Clear To Send interface lead 

RxD Shorted – alarm indicating a short circuit on the Receive Data interface lead 

RxC Shorted – alarm indicating a short circuit on the Receive Timing interface lead 

TxC Shorted – alarm indicating a short circuit on the Transmit Timing interface lead 

Alarm Options – Unit

EEPROM Checksum – Configuration Checksum error alarm

Front Panel Test – alarm indicating the DSE has been commanded into a test mode by means
front panel switches

STC Loopback – alarm indicating the DSE has been commanded into a test mode by the Tel
Serving Test Center (STC) 
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Associated Remote

Note If you have an Add Remote window open when you change the setting of the Circuit Type option, the
application automatically closes the Add Remote window. 

Add Remote, Point-to-Point Circuit

The window is shown in Figure 3-7 as it appears when the DSE is configured for use in a point
point circuit. 

Figure 3-7 Add Remote Window (Point-to-Point Circuit)

Perform the following procedure to add the remote DSU in a point-to-point circuit: 

1. Select Add Remote from Main Configuration window Navigate menu. The Add Remote 
window appears. The Serial Number field is blank when the window first appears. 

2. Click on the Wake Up Remote button. This commands the TEAM 5520 application to cr
the software structures that it requires in order to command and monitor the remote DSU
conjunction with the DSE. The application indicates success by displaying the serial num
of the associated remote DSU. 

3. Click OK to dismiss the window. 
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Add Remote, Multi-Point Circuit

The window is shown in Figure 3-8 as it appears when the DSE is configured for use in a mult
point circuit. The window is divided into two panels labeled Add Remote and Current Remotes
Add Remote panel contains the two fields and the button by which you perform the process
adding remote units. The Current Remotes panel is a display of units currently on the circui
identified by their drop numbers. 

In this window the Serial Number field is an entry field for you to specify the serial number o
unit you are adding, rather than a display field. A message appears above the Serial Numbe
reminding you that all remotes must be of the same type (all NMS 510 DSUs or all NMS 52
DSUs). The Remote Unit Type option in the Network Options window determines which mes
is displayed before there are any remotes added. If you change the setting of that option, you
add a remote until the change is saved to the unit. 

Figure 3-8 Add Remote Window (Multi-Point Circuit)

Perform the following procedure to add a remote DSU in a multi-point circuit: 

1. Select Add Remote from Main Configuration window Navigate menu. The Add Remote 
window appears. The Serial Number field is blank when the window first appears. 

2. Enter the 16-digit serial number of the remote you are adding. 

3. Click on the Drop entry field and from the resulting menu select the drop number you ar
assigning to unit. 

4. Click on the Add Remote button. This commands the TEAM 5520 application to create 
software structures that it requires in order to command and monitor the remote DSU in
conjunction with the DSE. The application indicates success by adding an entry for the n
drop number to the list displayed under Current Remotes. 

5. Click OK to dismiss the window. 
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Chapter 4: Maintenance

Maintenance Overview
The TEAM 5520 Maintenance application provides a group of functions for controlling the 
operation of an SC 5520 Data Set Emulator. 

You can start the TEAM 5520 Maintenance application by either of two methods: 

• Select a DSE symbol on the Shelf Map, then select the Maintenance option from the 
Configuration menu. 

• Click on the Select button of the Front Panel display, then click on Configuration and se
Maintenance from the resulting menu. 

The window title bar displays the application name, TEAM 5520 Maintenance. The Name fie
displays the shelf and slot identification for the DSE. See Figure 4-1.

Figure 4-1 Maintenance Window
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 4-1
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Maintenance Window Buttons

The Maintenance window provides the following three buttons. 

Front Panel – permits you to enable or disable the hardware switches on the front panel of th
5520 DSE. The label on the button appears as either Inhibit Front Panel or Enable Front Pan
it toggles between the two displays each time you click on the button. The button displays In
Front Panel when the switches are enabled, and it displays Enable Front Panel when they a
disabled. 

Reset to Factory Defaults – causes all options in the DSE to return to their factory default settin
When you click on this button the application displays a warning “Resetting to factory defaults
disrupt communications to the unit. Do you want to continue?” Click on the OK button in the
warning window to complete the reset, or click on the Cancel button to cancel the reset. 

Soft Reset – causes the DSE to perform a reset and resume operation using its current configu
When you click on this button the application displays a warning “Performing a soft reset wi
disrupt communications to the unit. Do you want to continue?” Click on the OK button in the
warning window to complete the reset, or click on the Cancel button to cancel the reset. 
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Chapter 5: Diagnostics

Overview
The TEAM 5520 Diagnostics application enables you to perform a variety of tests on the SC
DSE. Tests can involve just the local unit (the DSE), or the local unit, the remote DSU, and 
telephone lines that connect them. You can start the application by either of two methods: 

• Select a DSE symbol on the Shelf Map, then select Diagnostics from the Fault menu. 

• Click on the Select button of the Front Panel display, then click on Fault and select Diagn
from the resulting menu. 

Diagnostics Window

Beneath the menu bar and the Name field the Diagnostics window (See Figure 5-1) is divided into 
three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and stopping
functions

• Graphic panel – depicts the path followed by test data during the current test 

• Time and results panel – contains an input field for specifying the duration of a test that em
the DSE test pattern generator; displays Time Remaining and Test Results 

The Diagnostics window menu bar contains File and Navigate. The File menu has only the 
selection by which you dismiss the window. The Navigate menu also has a single selection: H
by which you can access a display of test results (see Figure 5-7) accumulated during the current 
diagnostic session. 
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 5-1
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Diagnostic Tests

The Diagnostics window provides three Tests, and three Test Patterns you can select for tho
that employ the DSE test pattern generator. The panel also includes two buttons, Start Test a
Test. The following Tests are available: 

Test Patterns 

Each Test and Pattern is accompanied by a check box by which you can select it with a mous
The Pattern check boxes are grayed out when the selected Test cannot be combined with an
test pattern. Line Loop and Remote Loop tests can be performed with or without a test patte

The three Test Patterns are: 

511 

2047 

15 bit  

Note Remote Loop without Pattern and Remote Loop with Pattern are only available with non-managed re
and only for point-to-point remotes.

Note In order to function, all Diagnostics procedures for the SC 5520 DSE require the unit to have data hig
bandwidth allocated to it on the shelf backplane, and to be receiving shelf timing. 

Note If the remote unit is an NMS 520 or NMS 510, the Remote Loop test is not available. The TEAM Diag
window will display the  Remote Loop Test selection will appear grayed-out. 

Test Description

Line Loop 
without Pattern

DSE initiates a local loopback, through which the DTE or external test 
equipment connected to the DTE interface can direct a test pattern. 
Must be ended by means of the Stop Test button. 

Line Loop 
with Pattern

DSE initiates a local loopback and activates its own test pattern 
generator/checker.

Data Loop DSE loops data it receives from the remote DSU back to the remote 
DSU. Must be ended by means of the Stop Test button. 

Remote Loop 
without Pattern
(see note)

DSE commands the remote DSU to initiate a digital loopback. A test 
pattern from the local DTE or from external test equipment connected 
to the local DTE interface can then be directed through the resulting 
test path. Must be ended by means of the Stop Test button. The 
remote DSU must recognize PN127 or V.54 loopback code. 

Remote Loop 
with Pattern
(see note)

DSE commands the remote DSU into digital loopback and activates 
its own test pattern generator/checker.The remote DSU must 
recognize PN127 or V.54 loopback code. 
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Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the selected DSE. 

1. Click on the check box next to the selected test: Line Loop, Remote Loop, or Data Loop

2. If you have selected Line Loop or Remote Loop you can perform the test either with an 
internally generated test pattern, or with externally generated and checked data. Under 
Pattern heading, click on 511, 2047, 15 Bit, or None (for external data). No Pattern selec
required for Data Loop. 

3. If you are using an internally generated test pattern select, in the Test Time field, how lon
test is to run before ending automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the data 
employed by the test. If you are using an internally generated test pattern, the Time Rem
field counts down from 100 to 0 percent. 

During a test that employs an internally generated test pattern the Test Results field disp
Running: followed by the number of errors detected; it displays In Loop when external da
in use. 

5. If you are using an internally generated test pattern, the test ends automatically at the e
the specified Test Time. For any other test, click on the Stop Test button to end the proc
The Stop Test button can also stop a test with test pattern prior to the Test Time limit tha
would end it automatically. 

Figure 5-1 Diagnostics Window
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Line Loop Test
The Line Loop test (See Figure 5-2) lets you isolate problems in the operation of the DSE and 
DTE interface. 

Figure 5-2 Line Loop Test

Line Loop with Test Pattern

Because the pattern generator and checker are internal to the DSE, the DTE interface is not
the Line Loop test path when you select a test pattern. The use of an internally generated test
enables the display of detected errors in the Test Results field.

 

Figure 5-3 Line Loop with Self-Test
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Remote Loop Test
In this test the DSE sends a remote loop command to the remote DSU, which must recognize
or V.54 loopback code. The selection of a V.54 or PN 127 remote loop command is made in
Diagnostic Options configuration window. In response, the remote DSU couples its receive d
its transmitter input for transmission back to the DSE at the local end (See Figure 5-4). This test is 
only available for unmanaged point-to-point remotes.

Figure 5-4 Remote Loop
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Remote Loop with Test Pattern

In this test the local DSE sends a Remote Loop command to the remote DSU, then generate
pattern that it transmits over the network to the remote DSU. The remote DSU loops the rec
pattern to its transmitter and sends it back to the DSE for analysis (See Figure 5-5). This test checks 
the DSE, the remote DSU, and the link. 

The use of an internally generated test pattern enables the display of detected errors in the 
Results field. 

Figure 5-5 Remote Loop with Test Pattern
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Data Loop Test
In Data Loopback (See Figure 5-6) local receive data is coupled to the transmitter input so that 
remote unit can perform a loopback test without commanding Remote Loopback. The remote
site is responsible for test pattern generation and checking in this test. 

.

Figure 5-6 Data Loop
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Diagnostics History
You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window (see Figure 5-7). 

Figure 5-7 Diagnostics History

The Diagnostics History displays information in five columns:

Start Time – date and time test began 

Test – name of the test 

Pattern – test pattern used for the test; N/A when internally generated pattern is not use

Test Blocks – number of data blocks sent during the test, applies only to tests with test p

Test Results – “Idle: n Errors” for a completed test with test pattern; “Not in loop [STOPPED
for a completed loop test without test pattern; “TEST STOPPED” for any test with test pa
that was ended by the Stop Test button 

To close the Diagnostics History window, click on either the OK button or the pushpin icon in
upper left corner of the window. During an on-going diagnostic session you can close and re
the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics window. 
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Chapter 6: NMS 520

Overview

The SC 5520 Data Set Emulator is a central site unit that can operate in conjunction with an
520 Data Service Unit (DSU) located at a remote site. The TEAM 5520 software supports a
range of functions for the remote NMS 520 DSU, as it does for the SC 5520 DSE. This chap
describes the NMS 520 functionality of the software and provides instructions for its use. 

Access to the NMS 520 Functions

Access to the NMS 520 functions takes place through the icon for the SC 5520 DSE that is 
to the NMS 520 DSU that you intend to work with. 

1. Display the shelf map. Any DSE that does not have an associated remote is identified by a b
around its icon symbol. Each DSE that has an associated remote is identified by an icon
symbol without a box. 

2. Double click on the icon symbol of the DSE that is linked to the DSU you intend to work w
The application responds by opening an Element submap that displays icons for the DS
the DSU with a connecting line to indicate that together they form a link. 

3. From this submap you can either click once on the DSU icon to select it and then acces
functions through the menu bar of the submap window, or double click on the DSU icon 
open the NMS 520 Front Panel display window. From the Front Panel display you can a
NMS 520 functions through Select button menus. 

Master/Remote Communications

Management communications take place on the secondary channel when the link between 
master SpectraComm 5520 DSE and the remote NMS 520 DSU is configured to be DDS II 
secondary channel. 

When the link is configured for DDS I or for clear channel the management communications
occupy the same channel that carries user data. When that is the case, each management 
communication has the effect of briefly interrupting or causing errors in the user data. Error 
correcting protocols and requests for retransmission protect user data against corruption, bu
effect does slightly reduce throughput. 

Note Reduction in throughput caused by management communications is most noticeable when the Front
display or the Alarm Detail window is open with Auto Poll enabled. The faster the scan rate setting se
for Auto Poll, the greater the effect on user data.
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Submap Window Menu Bar Access
The table on the following page illustrates how the NMS 520 functions of the TEAM 5520 
application are arranged on the menu bar at the top of the HPOV link submap window. The
shows only the menu selections for the NMS 520 functions. The submap window menus inc
other selections as well because the window is accessible to other applications. 

You must click on the DSU icon to select it before you open the menu you intend to use. 

The Performance menu Front Panel selection opens the Front Panel display window, which
provides access to menus through its Select button. All the menu selections shown above ap
the Select button menus except Front Panel and the Misc category. 

NMS 520 DSU Front Panel
The NMS 520 Front Panel display window (See Figure 6-1 and Figure 6-2) provides a graphical 
interface to a remote NMS 520 DSU. You can launch a Front Panel in either of two ways: 

• select the NMS 520 icon in the submap window, then select Front Panel from the Perform
menu for the window

• display the shelf sub-map that includes the unit you intend to work with, then double clic
mouse on the slot icon for the unit. 

The application responds by displaying a window that depicts the front panel of the selected
520 DSU unit. There are two NMS 520 DSU Front Panel displays, one for the model with 
Intelligent Front Panel (IFP) and one for the model without IFP. 

Menu Bar Menu Selections

Performance Front Panel...

Alarms...

DTE Status...

Line Statistics...

Configuration Maintenance...

Configure...

Fault Diagnose...

Misc Front Panel Poll Rate...

Note Pad
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Figure 6-1 NMS 520 IFP DSU Front Panel

Figure 6-2 NMS 520 Non-IFP DSU Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical uni

NS – No Signal indicates when lit that there is no signal at the network interface of the re
DSU 

SD – Send Data indicates when lit that the DSU is transmitting data 

RD – Receive Data indicates when lit that the DSU is receiving data 

RS – Request to Send indicates when lit that the DTE has data to transmit 

CS – Clear to Send indicates when lit that the DSU is prepared to transmit data 

CO – Carrier On indicates when lit that the DSU is receiving a carrier signal at its netwo
interface 

TR – Terminal Ready indicates when lit that the DTE is powered on

NORM – DSU mode indication, when lit indicates DSU in normal mode; when off indicat
DSU in diagnostic mode 

TEST/OK – indicates when lit that the DSU is receiving valid test data 

DBU – not a valid indicator in the TEAM application environment 

NETCON CO – not a valid indicator in the TEAM application environment 

NETCON DATA – not a valid indicator in the TEAM application environment 

NETCON RESP – not a valid indicator in the TEAM application environment 

NETCON TEST – not a valid indicator in the TEAM application environment 
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The application polls the DSU to keep the states of the LEDs in the Front Panel display curren
time of the most recent poll appears in the bottom left corner of the Front Panel display. The
is displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The Select button on the Front Panel displays provides access to menus for the rest of the N
functions of the TEAM 5520 application. The following table shows the arrangement of the S
button menus. It differs somewhat from the arrangement on the submap window menu bar.

 

The two Poll selections in the Select button menu determine when the application collects n
information from the DSE to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable
automatic polling. If you select Disable, the Front Panel window displays a static snaps
the LED states as they were at the last poll, either when the window was launched or 
subsequent Demand Poll. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Select Menu Items
Second Level 

Selections

Performance Alarms...

DTE Status...

Line Statistics...

Configuration Configure...

Maintenance...

Fault Diagnose...

Demand Poll

Auto Poll 15 seconds

30 seconds

60 seconds

Disable

Exit
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Performance Functions

Alarms

You can launch the NMS 520 Alarm Detail application from the Element submap Performan
Menu or from the front panel menu. The application displays the read-only Alarm Detail win
for the selected DSU (See Figure 6-3).

The TEAM 5520 application polls the DSU for changes in alarm conditions.

Figure 6-3 Alarm Detail Window

The Alarm Detail window displays alarms grouped into three categories: 

• Major

• Minor 

• Informational

Major Alarms

EEPROM Checksum – indicates that the non-volatile memory that stores the DSU configura
has become corrupted

No Signal – indicates the DSU is not receiving incoming signal 

Line Pairs Reversed – indicates wires connected incorrectly at the network interface 
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Streaming – indicates constant RTS condition 

DTP Loss – indicates loss of power at the DTE 

DCD Loss – indicates loss of incoming data

DCD Shorted – indicates a short circuit in the DCD interface lead

CTS Shorted – indicates a short circuit in the CTS interface lead

RXD Shorted – indicates a short circuit in the RXD interface lead

RXC Shorted – indicates a short circuit in the RXC interface lead

TXC Shorted – indicates a short circuit in the TXC interface lead

Frame Loss – indicates the DSU has missed at least two out of four framing bits in the incom
signal 

No DSU Response – indicates the remote DSU does not respond to polling by the master uni
only in DDS I operation) 

No DTE Polling – indicates the DTE connected to the remote DSU does not respond to polli
the master unit (valid only in DDS I operation) 

Minor Alarms

No Loop Current – indicates absence of dc current at the network interface 

TM Shorted – indicates a short circuit in the TM interface lead

RXD Loss – occurs when a unit that is configured for constant RX carrier experiences one m
without transitions in the Receive Data 

DSR Shorted – indicates a short circuit in the DSR interface lead

Bipolar Violation – indicates failure of consecutive ones to alternate states in the signal bein
received 

Jitter – indicates excessive jitter (phase shift) in the signal being received 

Signal To Noise – indicates unacceptable signal-to-noise ratio in the signal being received 

Rx Signal Low – indicates low signal level being received at the network interface 

Informational Alarms

Front Panel Test – indicates the DSU has been commanded into a test by means of its fron
switches 

DSR Loss – indicates the DSU is not outputting Data Set Ready to the DTE 

DTR Loss – indicates the DSU is not receiving Data Terminal Ready from the DTE 

TXD Loss – occurs when a unit that is configured for constant TX carrier experiences one m
without transitions in the Transmit Data 

STC Loopback – indicates the DSU has been commanded into a test by the Telco Serving 
Center (STC) 
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Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains the selections Demand Poll, Auto Poll, and Exit. Selecting Demand
causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Alarm Detail window displays a static snapshot of condition
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The View menu consists of three selections: Major, Minor, and Informational, each with a ch
box beside it. To remove an alarm category from the window display, click on its check box s
it is unchecked. Clicking a box so that it is checked restores the corresponding category to t
display. 

DTE Status

You can launch the NMS 520 DTE Status application from the Element submap Performance
or from the front panel menu. The application displays the read-only DTE Status window for
selected DSU (See Figure 6-4). The window displays indicators for the states of the EIA signals
the DTE interface. Dark green indicates Off, light green indicates On, and light green with a
superimposed two-headed arrow indicates transitions. 

Status Window Menu

The Status window has a File menu in its menu bar with the selection
Demand Poll, Auto Poll, and Exit. 

Selecting Demand Poll causes an immediate update of the display. A
Poll enables you to select updates at 15, 30, or 60 second intervals, o
disable automatic polling. If you select Disable, the Status window 
displays a static snapshot of the EIA indicators as they were at the last
either when the window was launched or a subsequent Demand Poll.

The time of the most recent poll appears in the bottom left corner of t
window. The time is displayed in white when Auto Poll is enabled, and
yellow when it is disabled. 

Figure 6-4 DTE Status Window
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Line Statistics

You can launch the Line Statistics application from the submap Performance Menu or from 
front panel menu. As shown in Figure 6-5, the application displays eight categories of line 
performance statistics accumulated by the unit over the most recent 15 minutes. The statist
displayed on 15 lines, each representing one minute of the displayed interval. 

Line Statistics Window Menus

The Line Statistics window has a File menu that consists of Refresh and Exit selections. Th
Refresh selection causes the window to display the latest available data. The window is not
dynamic display, so you should use the Refresh selection occasionally when you keep the w
open for long periods. The Exit selection dismisses the Line Statistics window. 

Figure 6-5 Line Statistics Window 

Configuration Functions – Configure

You can launch the NMS 520 Configuration function from the Element submap Configuratio
Menu or from the front panel menu. When you launch the window, it initially displays the read-
NMS 520 Configuration window, which has a File menu and a Navigate menu in its menu b

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating configur

• Save to Unit, which puts the new configuration into use by the DSU 

• Load Template, by which you can recall a stored configuration template that you can then
to the DSU either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstation f
future use as a template 
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• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template 

• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the four read/write windows by which you can con
various aspects of DSU operation: 

• System Options

• Network Options

• DTE Options

• Alarms Reported

Main Configuration Window

The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the DSU. From the Navigate menu you 
select the individual configuration windows in which you make changes. The File menu commands 
the storage and retrieval of configuration settings. The contents of the two menus appear be

The Main Configuration window title bar displays the function name, NMS 520 Configuration.
main body of the window contains read-only items that identify the DSU and provide informa
about its operations. 

Menu Buttons Menu Selections
Further 

Selections

File Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate System Options... 

Network Options... 

DTE Options... 

Alarms Reported... 

All Screens... 
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Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

Name: shelf and slot identification for the master DSE followed by the 
slot:line:drop address of the DSU

Serial Number: displays the serial number of the DSU

Firmware Revision: displays the revision level of the DSU operating code

DDS Version: displays the revision level of the MIB files that enable SNMP con

NMS 520 MIB Version: displays the revision level of the MIB files that enable SNMP con

Figure 6-6 Main Configuration Window

System Options

The NMS 520 System Options configuration window contains three options. 

Figure 6-7 NMS 520 System Option Configuration Window
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Alarm Scan – permits you to enable or inhibit (disable) the DSU alarm scan

Options:

Enable 

Disable 

Front Panel – permits you to disable the test switches on the front panel of a non-IFP DSU a
protection against any inadvertent interruption of its operation. This option is not valid when
configuring an NMS 520 IFP DSU. 

Options:

Enable – DSU front panel test switches are operational 

Disable – DSU front panel test switches are disabled 

Rsp Timeout – selects the length of time the SCM waits for a response from the DSU before
declares a No Response condition. 

Options:

2, 4, 6, 8 seconds

NMS 520 Network Options

The NMS 520 Network Options configuration window (Figure 6-8) appears when you select 
Network Options from the Main Configuration window Navigate menu. The window contains
panels labeled Network Parameters and Circuit Parameters. 

Figure 6-8 NMS 520 Network Options Configuration Window
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Network Parameters

Line Type – read-only field displays the type of service to which the DSU is connected

Options:

Clear Channel 

DDS-I 

DDS-SC 

Carrier  – selects the combination of transmit and receive carrier modes (constant/switched)
used by the DSU 

Options:

Tx Constant, Rx Constant – for use on a point-to-point circuit 

Tx Constant, Rx Switched – for use when the DSU is the master unit on a multi-point circu

Tx Switched, Rx Constant – for use when the DSU is a remote unit on a multi-point circuit 

Tx Switched, Rx Switched – for use when required by specialized applications

Data Rate – read-only field displays the data rate and mode (synchronous/asynchronous) in u
the DSU 

Options:

2.4 Kbps - Async 

2.4 Kbps - Sync 

4.8 Kbps - Async 

4.8 Kbps - Sync 

9.6 Kbps - Async 

9.6 Kbps - Sync 

19.2 Kbps - Async 

19.2 Kbps - Sync 

56 Kbps - Sync 

64 Kbps - Sync 

Circuit Parameters

Tx Clock Source – this option is forced to Receive and grayed out 

Buffer Clock – selects the source of timing for the buffer between the DSU and its DTE 

Options:

Internal – selects timing provided by the DSU internal clock 

External – selects timing provided by the DTE; when External is selected for Tx Clock So
this selection is forced and cannot be changed 
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Zero Encoding – selects Zero Encoding. This feature can be used in point-to-point 56 kbps D
SC applications to enable the DTE to transmit all spaces (zeros) without violating the ones d
requirements of DDS. The feature must be enabled at both units. 

Options:

Enable – DSU prevents the all space condition at the expense of reduced secondary cha
bandwidth 

Disable – DSU does not prevent the all space condition 

Sentry Timer – selects the minimum time interval permitted between alarm reports in a poin
point link. This option is grayed out when a multipoint Circuit Type is selected. 

Options:

Disable 

5 Minutes to 125 Minutes – in five minute increments 

Rmt Rsp Interval – selects the minimum time interval permitted between alarm reports in a m
point link. This option is grayed out when a point-to-point Circuit Type is selected. 

Options:

Disable 

10 Seconds to 120 Seconds – in ten second increments 

Alarm Hysteresis – selects the minimum time an alarm condition must persist in order to be 
reported 

Options:

10 Seconds to 120 Seconds – in ten second increments 

Circuit Assurance – when this option is enabled the DSU clamps Clear To Send when it det
any of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or 
Inactive Channel Code 

Options:

Disable 

Enable 

System Status – when this option is enabled the DSU clamps Data Set Ready when it detect
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code 

Options:

Disable 

Enable 
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DTE Options

The NMS 520 DTE Options configuration window contains four groups of options under the
headings Interface, Control Parameters, Async Parameters, and Diagnostic Parameters. 

Figure 6-9 DTE Option Configuration Window

Interface 

Interface Type – specifies the DTE port type 

Options:

RS232 – EIA/TIA-232-E interface 

V.35 – ITU-T V.35 interface 

Auto – the DSU automatically senses the interface type being used by the DTE 

Interface Adapter – read-only field displays whether or not the DSU has a Data Rate Adapte
(DRA) card installed 

Options:

None 

Installed 
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Control Parameters

AAS – selects whether or not the DSU provides Automatic Anti-Streaming protection, and the
limit it enforces when the feature is enabled 

Options: 

Disable

5 Seconds

10 Seconds

30 Seconds

45 Seconds

Constant DSR – selects the DSU to output either a constant or a switched Data Set Ready s
to its DTE. 

Options: 

Disable – switched DSR signal controlled by DTR 

Enable – constant DSR signal

CTS Delay – selects the delay (if any) between the DSU receiving Request To Send from the
and returning Clear To Send to the DTE. 

Options: 

CTS ON – no delay; grayed out when Tx Constant is selected in the Carrier option of the
Network Options configuration window

Fixed 3 Char – equivalent to three character times 

0 msec 

30 msec 

60 msec 

90 msec 

HDLC Invert – selects whether or not the DSU uses inverted channel data from the DTE. D
inversion is used primarily with DDS-SC 56 kbps circuits, to enhance data quality in a networ
does not provide B8ZS coding. 

CAUTION
You must consider the following factors when you change the setting of this option: 

When changing the setting of this option, set only this option and save the change to the unit. Do
combine it with any other configuration changes. 

The option must be set the same at both ends of the link. 

You must make changes at the remote DSU first, before you change the option setting at the DS

Changing the option at the remote causes loss of communication between the remote and maste
until you change the option setting at the master. 
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Options: 

Disable – normal data 

Enable – inverted data

Async Parameters

The Async Parameters options are grayed out when a synchronous Data Rate is selected in
Network Interface configuration. 

Character Size – selects the number of bits per asynchronous character, including start and
bits 

Options: 

11 Bits 

10 Bits 

9 Bits 

8 Bits 

Over Speed – selects the percentage above its configured normal operating rate at which the
can accommodate receive data. It performs the over speed compensation by shaving stop b

Options: 

1%

2.3%

Suppression – determines what actions the DSU takes concerning transmit and receive End o
(EOT) 

Options: 

Disable – the DSU does not insert EOT at the end of transmissions, and does not delete 
the end of received signals 

Rx EOT – the DSU deletes EOT from the end of received signals; it does not insert EOT 
end of transmissions 

Tx EOT – the DSU inserts EOT at the end of transmissions; it does not delete it from the e
received signals 

Rx + Tx EOT – the DSU inserts EOT at the end of transmissions, and deletes it from the e
received signals 

Rate Adaption – selects the speed relationship between the DTE interface and the DDS circ

Options: 

Disable 

1200 

600 

1800 to 2400 
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Diagnostic Parameters

Data Set Ready – selects how the DSU controls the DSR output to the DTE during test mode

Options:

Off During Test 

Normal – DSR operates in the same way that it is optioned to function during data mode
operations 

Line Loopback Test Points – selects whether a Line Loopback command causes the DSU on
loop transmit data back to the DTE, or also to loop receive data back to the network 

Options: 

Network & DTE – Line Loopback command causes DSU to loop data in both directions

DTE Only – Line Loopback command causes DSU to loop data back to DTE only 

Alarms Reported

The NMS 520 Alarms Reported configuration window (Figure 6-10) lets you configure which 
alarm conditions are to be reported for the DSU and which are not. The window contains th
panels labeled Network, DTE, and Unit as shown below. 

Figure 6-10 Alarms Reported Configuration Window
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Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection
located to its left. You can select or de-select individual alarm options by simply clicking the m
button on the appropriate selection fields. When an option is selected for its alarm to be rep
its selection field is highlighted. The selection fields next to alarm options that are not to be rep
are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option fie
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection fields. 

After clicking Report All or Report None you can then change the state of individual fields as
needed. 

Alarms Reported Buttons

Report All  – unmasks all alarms.

Report None – masks all alarms.

Reset – replaces the information in the fields with the most recently read information from the D 
Note that this button does not initiate a read of information from the DSU.

OK  – saves your changes and closes the window.

Cancel – cancels your changes and closes the window.

Network Alarms

Each Network alarm, when unmasked, requires you to specify a threshold against which it i
evaluated. 

Alarm Interval  - determines the time span for threshold evaluation. 

Options:

1 min, 5 min, 10 min, 15 min 

Bipolar Violation  - lets you mask or unmask Bipolar Violation alarms. A network Bipolar 
Violation occurs when the signal the unit receives at its network interface does not alternate
between signal levels as required for Alternate Mark Inversion (AMI) or Bipolar with 8 Zero 
Substitution (B8ZS) data encoding. The alarm occurs when the number of BPVs in the rece
signal during one Alarm Interval exceeds the selected threshold. 

Options:

1, 2, 5, 10, 20, 40, 60, 80, 99 

Jitter  - lets you mask or unmask Jitter alarms. The alarm occurs when the percent of jitter in
received signal remains above the selected threshold for at least one Alarm Interval. 

Options:

1%, 2%, 5%, 10%, 20%, 40%, 60%, 80%, 99% 
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Frame Loss - lets you mask or unmask Frame Loss alarms. The alarm occurs when the num
lost frames in the received signal during one Alarm Interval exceeds the selected threshold.

Options:

1, 2, 5, 10, 20, 40, 60, 80, 99 

Rx Signal Low - lets you mask or unmask Rx Signal Low alarms. The alarm occurs when th
strength of the received signal remains below the selected threshold for at least one Alarm In

Options:

6 dB, 0 dB, -5 dB, -10 dB, -20 dB, -30 dB, -40 dB, -50 dB 

Signal to Noise - lets you mask or unmask Signal to Noise Ratio alarms. The alarm occurs w
the ratio of signal to noise in the received signal remains poorer than the selected threshold
least one Alarm Interval. 

Options:

0, 5, 10, 15, 20, 25, 30, 40, 50 

DTE

DTP Loss – alarm indicating loss of Data Terminal Power 

DCD Loss – alarm indicating loss of Data Carrier Detect

DSR Loss – alarm indicating loss of Data Set Ready

DTR Loss – alarm indicating loss of Data Terminal Ready 

RxD Loss – alarm indicating no receive data from the remote DSU 

TxD Loss – alarm indicating no transmit data from the DTE 

TM Shorted – alarm indicating a short circuit on the Test Mode interface lead 

Streaming – alarm indicating a streaming condition at the DTE interface 

DCD Shorted – alarm indicating a short circuit on the Data Carrier Detect interface lead 

DSR Shorted – alarm indicating a short circuit on the Data Set Ready interface lead 

CTS Shorted – alarm indicating a short circuit on the Clear To Send interface lead 

RxD Shorted – alarm indicating a short circuit on the Receive Data interface lead 

RxC Shorted – alarm indicating a short circuit on the Receive Timing interface lead 

TxC Shorted – alarm indicating a short circuit on the Transmit Timing interface lead 

Unit

No Signal – alarm indicating there is no signal at the DSU network interface 

Line Pairs Reversed – alarm indicating the transmit and receive line pairs are reversed 

STC Loopback – alarm indicating the DSU has been commanded into a test mode by the Tel
Serving Test Center (STC) 

Front Panel Test – alarm indicating the DSU has been commanded into a test mode by means
front panel switches (valid only for non-IFP NMS 520 DSU)

No Loop Current – alarm indicating that network sealing current is inadequate or absent 

EEPROM Checksum – Configuration Checksum error alarm
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Configuration Functions – Maintenance

You can launch the NMS 520 Maintenance function from the Element submap Configuration 
or from the front panel menu. The application displays one read/write window by which you 
control some aspects of DSU operation that fall outside the scope of Configuration. See Figure 
6-11. 

The window title bar displays the function name, NMS 520 Maintenance. The Name field dis
the shelf name and the slot number of the master DSE followed by the slot:line:drop address
DSU. The File menu contains only the selection Exit, by which you can dismiss the window.

Maintenance Window Buttons

The Maintenance window provides the following three buttons. 

Front Panel – permits you to enable or disable the hardware test switches on the front pane
non-IFP DSU. The label on the button appears as either Inhibit Front Panel or Enable Front 
and it toggles between the two displays each time you click on the button. The button displa
Inhibit Front Panel when the switches are enabled, and it displays Enable Front Panel when t
disabled. This button is not valid when you are working with an NMS 520 IFP DSU. 

Reset to Factory Defaults – causes all options in the DSU to return to their factory default settin
When you click on this button the application displays a warning “Resetting to factory defaults
terminate communications to the unit. Do you want to continue?” Click on the OK button in t
warning window to complete the reset, or click on the Cancel button to cancel the reset. 

Soft Reset – causes the DSU to perform a reset and resume operation using its current 
configuration. When you click on this button the application displays a warning “Performing a
reset will disrupt communications to the unit. Do you want to continue?” Click on the OK butto
the warning window to complete the reset, or click on the Cancel button to cancel the reset.

Figure 6-11 Maintenance Window
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Diagnostics

You can launch the NMS 520 Diagnostics function from the submap Fault menu or from the
panel menu. 

The application displays one read/write window by which you can control a variety of test func
on the DSU. 

Diagnostics Window

Beneath the menu bar and the Name field the Diagnostics window (See Figure 6-12) is divided into 
three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and stopping
functions

• Graphic panel – depicts the path followed by test data during the current test 

• Time and results panel – contains an input field for specifying the duration of a test that em
the DSU test pattern generator; displays Time Remaining and Test Results 

The Diagnostics window menu bar contains File and Navigate. The File menu has only the 
selection by which you dismiss the window. The Navigate menu also has a single selection: H
by which you can access a display of test results (see Figure 6-13) accumulated during the curren
diagnostic session. 

Tests

The Diagnostics window selection panel lists three Tests to choose from, and two Patterns y
select for those tests that employ the DSU test pattern generator. The panel also includes a
field for the User Defined test pattern, and two buttons: Start Test and Stop Test. 

The following Tests are available: 

Line Loop (performed only with test pattern) 

End To End (performed only with test pattern) 

Dataloop (can be performed with or without test pattern) 

Delay Test 

The Patterns are: 

511 bit 

2047 bit 

15 bit 

Each Test and Pattern is accompanied by a check box on which you can click to select it. The 
check boxes are grayed out when the selected Test cannot be combined with an internal test
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Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the DSU. 

1. Click on the check box next to the selected test. If you are running the Delay Test, go to S

2. Under the Pattern heading, click on your selected pattern. The Dataloop test also suppo
selection None (for external data). 

3. If you are using an internally generated test pattern select, in the Test Time field, how lon
test is to run before ending automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the data 
employed by the test. If you are using an internally generated test pattern, the Time Rem
field counts down from 100 to 0 percent. 

During a test that employs an internally generated test pattern the Test Results field displa
number of errors detected; it displays In Loop when external data is in use. 

5. If you are using an internally generated test pattern, the test ends automatically at the e
the specified Test Time. For any other test, click on the Stop Test button to end the proc
The Stop Test button can also stop a test with test pattern prior to the Test Time limit tha
would end it automatically. 

Figure 6-12 NMS 520 Diagnostics Window
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Diagnostics Table

The table below briefly describes the available tests.

Diagnostics History

You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window (see Figure 6-13). 

Figure 6-13 Diagnostics History

The Diagnostics History window displays information in five columns:

Start Time – date and time test began 

Test – name of the test 

Pattern – test pattern used for the test; N/A when internally generated pattern is not use

Test Blocks – number of data blocks sent during the test, applies only to tests with test p

Test Results – “Idle: n/n Bit/Block Errors” for a completed test with test pattern; “Not in loo
[STOPPED]” for a completed loop test without test pattern; “TEST STOPPED” for any te
with test pattern that was ended by the Stop Test button; “n ms.” for Delay Test

Test Description

Line Loop 
(with Pattern)

DSU initiates a loopback at its network interface and activates its test 
pattern generator/checker

End To End 
(with Pattern)

DSU activates its test pattern generator/checker and transmits the 
pattern on its link to the DSE. DSU checks for errors in the signal it 
receives, which is generated by the DSE. 

Dataloop 
(without 
Pattern)

DSE transmits a command on the link that causes the DSU to loop 
data back to the DSE; DTE or external test equipment at the DSE is 
responsible for generating and checking a test pattern. 

Dataloop
(with Pattern)

DSE transmits the loopback command to the DSU, and activates its 
test pattern generator/checker to transmit the pattern and check for 
errors in the signal it receives back. 

Delay Test DSU transmits and receives a test signal, which is looped back by the 
DSE; the DSU measures the round trip time (delay). 
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To close the Diagnostics History window, click on either the OK button or the pushpin icon in
upper left corner of the window. During an on-going diagnostic session you can close and re
the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics window. 

Miscellaneous Functions

Front Panel Poll Rate

You can open the Front Panel Poll Rate window (See Figure 6-14) from the Shelf Map Misc Menu. 
The setting you select in this window determines the initial polling rate for Front Panel displa
each time they are opened. 

The rate selection is a global function. It selects initial polling rate for all front panel displays lin
to a TEAM Core application, regardless of which individual application you access it from. 

There are four selections, each accompanied by a checkbox: 

Slow 

Normal 

Fast 

Demand Poll Only 

The File menu in the menu bar contains two selections: Save to File and Exit. 

To set the desired polling rate, first click on the appropriate checkbox and then select Save 
from the File menu. The precise polling frequency that results from a setting of Slow, Norma
Fast depends on a number of factors. The higher the rate, the more communication and pro
capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a se
by means of the Auto Poll selection in the Select button menu. Changes you make with that
selection are not retained when the display is closed. 

To dismiss the window, select Exit from the File menu. 

Figure 6-14 Front Panel Poll Rate Window
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You can launch the Note Pad application from the Shelf Map Misc Menu. The application op
shell tool on the workstation running the TEAM software. You can use the shell tool to run a
editor, mail tool, or any other software that resides on the workstation. The Note Pad applic
provides this access for keeping records on the system. 
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Chapter 7:  NMS 510

Overview

The SC 5520 Data Set Emulator is a central site unit that can operate in conjunction with an
510 Data Service Unit (DSU) located at a remote site. The TEAM 5520 software supports a
range of functions for the remote NMS 510 DSU, as it does for the SC 5520 DSE. This chap
describes the NMS 510 functionality of the software and provides instructions for its use. 

Access to the NMS 510 Functions

Access to the NMS 510 functions takes place through the icon for the SC 5520 DSE that is 
to the NMS 510 DSU that you intend to work with. 

1. Display the shelf map. Any DSE that does not have an associated remote is identified by a b
around its icon symbol. Each DSE that has an associated remote is identified by an icon
symbol without a box. 

2. Double click on the icon symbol of the DSE that is linked to the DSU you intend to work w
The application responds by opening an Element submap that displays icons for the DS
the DSU with a connecting line to indicate that together they form a link. 

3. From this submap you can either click once on the DSU icon to select it and then acces
functions through the menu bar of the submap window, or double click on the DSU icon 
open the NMS 510 Front Panel display window. From the Front Panel display you can a
NMS 510 functions through Select button menus. 

Master/Remote Communications

Management communications take place on the secondary channel when the link between 
master SpectraComm 5520 DSE and the remote NMS 510 DSU is configured to be DDS II 
secondary channel. 

When the link is configured for DDS I or for clear channel the management communications
occupy the same channel that carries user data. When that is the case, each management 
communication has the effect of briefly interrupting or causing errors in the user data. Error 
correcting protocols and requests for retransmission protect user data against corruption, bu
effect does slightly reduce throughput. 

Note Reduction in throughput caused by management communications is most noticeable when the Front
display or the Alarm Detail window is open with Auto Poll enabled. The faster the scan rate setting 
lected for Auto Poll, the greater the effect on user data. 
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Submap Window Menu Bar Access

The table on the following page illustrates how the NMS 510 functions of the TEAM 5520 
application are arranged on the menu bar at the top of the Element submap window. The table
only the menu selections for the NMS 510 functions. The submap window menus include ot
selections as well because the window is accessible to other applications. 

You must click on the DSU icon to select it before you open the menu you intend to use. 

The Performance menu Front Panel selection opens the Front Panel display window, which
provides access to menus through its Select button. All the menu selections shown above ap
the Select button menus except Front Panel and the Misc category. 

NMS 510 DSU Front Panel

The NMS 510 Front Panel display window (See Figure 7-1) provides a graphical interface to a 
remote NMS 510 DSU. You can launch a Front Panel in either of two ways: 

• select the NMS 510 icon in the Element submap window, then select Front Panel from t
Performance menu for the window

• display the shelf sub-map that includes the unit you intend to work with, then double clic
mouse on the icon for the unit. 

The application responds by displaying a window that depicts an NMS 510 DSU. The applic
employs the same display regardless of whether or not the selected DSU is equipped with a
Intelligent Front Panel (IFP). 

Figure 7-1 NMS 510 DSU Front Panel

Menu Bar Menu Selections

Performance Front Panel...

Alarms...

DTE Status...

Configuration Maintenance...

Configure...

Fault Diagnose...

Misc Front Panel Poll Rate...

Note Pad
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The LEDs shown in the display reflect the states of the actual indicators on the physical uni

NS – No Signal indicates when lit that there is no signal at the network interface of the re
DSU 

SD – Send Data indicates when lit that the DSU is transmitting data 

RD – Receive Data indicates when lit that the DSU is receiving data 

RS – Request to Send indicates when lit that the DTE has data to transmit 

CS – Clear to Send indicates when lit that the DSU is prepared to transmit data 

CO – Carrier On indicates when lit that the DSU is receiving a carrier signal at its netwo
interface 

TR – Terminal Ready indicates when lit that the DTE is powered on

NORM – DSU mode indication, when lit indicates DSU in normal mode; when off indicat
DSU in diagnostic mode 

TEST/OK – indicates when lit that the DSU is receiving valid test data 

DBU – not a valid indicator in the TEAM application environment 

NETCON CO – not a valid indicator in the TEAM application environment 

NETCON DATA – not a valid indicator in the TEAM application environment 

NETCON RESP – not a valid indicator in the TEAM application environment 

NETCON TEST – not a valid indicator in the TEAM application environment 

The application polls the DSU to keep the states of the LEDs in the Front Panel display curren
time of the most recent poll appears in the bottom left corner of the Front Panel display. The
is displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The Select button on the Front Panel displays provides access to menus for the rest of the N
functions of the TEAM 5520 application. The following table shows the arrangement of the S
button menus. It differs somewhat from the arrangement on the Element submap window me

Select Menu Items
Second Level 

Selections

Performance Alarms...

DTE Status...

Configuration Configure...

Maintenance...

Fault Diagnose...

Demand Poll

Auto Poll 15 seconds

30 seconds

60 seconds

Disable

Exit
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The two Poll selections in the Select button menu determine when the application collects n
information from the DSU to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Front Panel window displays a static snapshot of the L
states as they were at the last poll, either when the window was launched or a subseque
Demand Poll. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Performance Functions

Alarms

You can launch the NMS 510 Alarm Detail application from the Element submap Performan
Menu or from the front panel menu. The application displays the read-only Alarms Detail win
for the selected DSU (See Figure 7-2).

The TEAM 5520 application polls the DSU for changes in alarm conditions.

The Alarm Detail window displays alarms grouped into three categor

• Major

• Minor 

• Informational

Figure 7-2 Alarm Detail Window
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Major Alarms

EEPROM Checksum – indicates that the non-volatile memory that stores the DSU configura
has become corrupted

DTP Loss – indicates loss of power at the DTE 

DCD Loss – indicates loss of incoming data

No Signal – indicates the DSU is not receiving incoming signal 

Streaming – indicates constant RTS condition 

Frame Loss – indicates the DSU has missed at least two out of four framing bits in the incom
signal 

Minor Alarm

RXD Loss – occurs when a unit that is configured for constant RX carrier experiences one m
without transitions in the Receive Data 

Informational Alarms

Front Panel Test – indicates the DSU has been commanded into a test by means of its fron
switches 

DSR Loss – indicates the DSU is not outputting Data Set Ready to the DTE 

DTR Loss – indicates the DSU is not receiving Data Terminal Ready from the DTE 

TXD Loss – occurs when a unit that is configured for constant TX carrier experiences one m
without transitions in the Transmit Data 

STC Loopback – indicates the DSU has been commanded into a test by the Telco Serving 
Center (STC) 

Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains the selections Demand Poll, Auto Poll, and Exit. Selecting Demand
causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Alarm Detail window displays a static snapshot of condition
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The View menu consists of three selections: Major, Minor, and Informational, each with a ch
box beside it. To remove an alarm category from the window display, click on its check box s
it is unchecked. Clicking a box so that it is checked restores the corresponding category to t
display. 
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DTE Status

You can launch the NMS 510 DTE Status application from the Element submap Performance
or from the front panel menu. The application displays the read-only DTE Status window for
selected DSU (See Figure 7-3). The window displays indicators for the states of the EIA signals
the DTE interface. Dark green indicates Off, light green indicates On, and light green with a
superimposed two-headed arrow indicates transitions. 

Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto Po
Exit. 

Selecting Demand Poll causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Status window displays a static snapshot of the EIA indicat
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

Figure 7-3 DTE Status Window 

Configuration Functions – Configure

You can launch the NMS 510 Configuration function from the Element submap Configuratio
Menu or from the front panel menu. When you launch the window, it initially displays the read-
NMS 510 Configuration window, which has a File menu and a Navigate menu in its menu b

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating configur

• Save to Unit, which puts the new configuration into use by the DSU 
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• Load Template, by which you can recall a stored configuration template that you can then
to the DSU either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstation f
future use as a template 

• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template 

• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the four read/write windows by which you can con
various aspects of DSU operation: 

• System Options

• Network Options

• DTE Options

• Alarms Reported

Main Configuration Window

The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the DSU. From the Navigate menu you 
select the individual configuration windows in which you make changes. The File menu commands 
the storage and retrieval of configuration settings. The contents of the two menus appear be

The Main Configuration window title bar displays the function name, NMS 510 Configuration.
main body of the window contains read-only items that identify the DSU and provide informa
about its operations. 

Menu Buttons Menu Selections
Further 

Selections

File Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Navigate System Options... 

Network Options... 

DTE Options... 

Alarms Reported... 

All Screens... 
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Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

Name: shelf and slot identification for the master DSE followed by the 
slot:line:drop address of the DSU

Serial Number: displays the serial number of the DSU

Firmware Revision: displays the revision level of the DSU operating code

DDS Version: displays the revision level of the MIB files that enable SNMP con

NMS 510 MIB Version: displays the revision level of the MIB files that enable SNMP con

 

Figure 7-4 Main Configuration Window

System Options

The NMS 510 System Options configuration window contains three options. 

Figure 7-5 NMS 510 System Options Configuration Window

Alarm Scan – permits you to enable or disable the DSU alarm scan

Options:

Enable 

Disable 
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Front Panel – permits you to disable the test switches on the front panel of the DSU as prote
against any inadvertent interruption of its operation. 

Options:

Enable – DSU front panel test switches are operational 

Disable – DSU front panel test switches are disabled 

Rsp Timeout – selects the length of time the SCM waits for a response from the DSU before
declares a No Response condition. 

Options:

2, 4, 6, 8 seconds

NMS 510 Network Options

The NMS 510 Network Options configuration window (Figure 7-6) appears when you select 
Network Options from the Main Configuration window Navigate menu. The window contains
panels labeled Network Parameters and Circuit Parameters. 

Figure 7-6 NMS 510 Network Options Configuration Window

Network Parameters

Line Type – read-only field displays the type of service to which the DSU is connected

Options:

Clear Channel 

DDS-I 

DDS-SC 
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Carrier  – selects the combination of transmit and receive carrier modes (constant/switched)
used by the DSU 

Options:

Tx Constant, Rx Constant – for use on a point-to-point circuit 

Tx Constant, Rx Switched – for use when the DSU is the master unit on a multi-point circu

Tx Switched, Rx Constant – for use when the DSU is a remote unit on a multi-point circuit 

Tx Switched, Rx Switched – for use when required by specialized applications

Data Rate – read-only field displays the data rate and mode (synchronous/asynchronous) in u
the DSU 

Options:

2.4 Kbps - Async 

2.4 Kbps - Sync 

4.8 Kbps - Async 

4.8 Kbps - Sync 

9.6 Kbps - Async 

9.6 Kbps - Sync 

19.2 Kbps - Async 

19.2 Kbps - Sync 

56 Kbps - Sync 

64 Kbps - Sync 

Circuit Parameters

Tx Clock Source – this option is forced to Receive and grayed out

Buffer Clock – selects the source of timing for the buffer between the DSU and its DTE 

Options:

Internal – selects timing provided by the DSU internal clock 

External – selects timing provided by the DTE; when External is selected for Tx Clock So
this selection is forced and cannot be changed 

Zero Encoding – selects Zero Encoding. This feature can be used in point-to-point 56 kbps D
SC applications to enable the DTE to transmit all spaces (zeros) without violating the ones d
requirements of DDS. The feature must be enabled at both units. 

Options:

Enable – DSU prevents the all space condition at the expense of reduced secondary cha
bandwidth 

Disable – DSU does not prevent the all space condition 
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Circuit Assurance – when this option is enabled the DSU clamps Clear To Send when it det
any of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or 
Inactive Channel Code 

Options:

Disable 

Enable 

System Status – when this option is enabled the DSU clamps Data Set Ready when it detect
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code 

Options:

Disable 

Enable 

DTE Options

The NMS 510 DTE Options configuration window contains four groups of options under the
headings Interface, Control Parameters, Async Parameters, and Diagnostic Parameters. 

Figure 7-7 DTE Options Configuration Window
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Interface 

Interface Adapter – read-only field displays whether or not the DSU has a Data Rate Adapte
(DRA) card installed 

Options:

None 

Installed 

Control Parameters

AAS – selects whether or not the DSU provides Automatic Anti-Streaming protection, and the
limit it enforces when the feature is enabled 

Options: 

Disable

5 Seconds

10 Seconds

30 Seconds

45 Seconds

Constant DSR – selects the DSU to output either a constant or a switched Data Set Ready s
to its DTE. 

Options: 

Disable – switched DSR signal controlled by DTR 

Enable – constant DSR signal

CTS Delay – selects the delay (if any) between the DSU receiving Request To Send from the
and returning Clear To Send to the DTE. This option is forced to CTS On and grayed out wh
Constant Tx Carrier is selected in the Carrier option of the Network Options window. 

Options: 

CTS ON – no delay; grayed out when Tx Constant is selected in the Carrier option of the Net
Options configuration window

Fixed 3 Char – equivalent to three character times 

0 msec 

30 msec 

60 msec 

90 msec 

HDLC Invert – selects whether or not the DSU uses inverted channel data from the DTE. D
inversion is used primarily with DDS-SC 56 kbps circuits, to enhance data quality in a networ
does not provide B8ZS coding. 
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Options: 

Disable – normal data 

Enable – inverted data

Async Parameters

The Async Parameters options are grayed out when a synchronous Data Rate is selected in
Network Interface configuration. 

Character Size – selects the number of bits per asynchronous character, including start and
bits 

Options: 

11 Bits 

10 Bits 

9 Bits 

8 Bits 

Over Speed – selects the percentage above its configured normal operating rate at which the
can accommodate receive data. It performs the over speed compensation by shaving stop b

Options: 

1% 

2.3%

Suppression – determines what actions the DSU takes concerning transmit and receive End o
(EOT) 

Options: 

Disable – the DSU does not insert EOT at the end of transmissions, and does not delete 
the end of received signals 

Rx EOT – the DSU deletes EOT from the end of received signals; it does not insert EOT 
end of transmissions 

Tx EOT – the DSU inserts EOT at the end of transmissions; it does not delete it from the e
received signals 

Rx + Tx EOT – the DSU inserts EOT at the end of transmissions, and deletes it from the e
received signals 

CAUTION
You must consider the following factors when you change the setting of this option: 

When changing the setting of this option, set only this option and save the change to the unit. Do
combine it with any other configuration changes. 

The option must be set the same at both ends of the link. 

You must make changes at the remote DSU first, before you change the option setting at the DS

Changing the option at the remote causes loss of communication between the remote and maste
until you change the option setting at the master.
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Rate Adaption – specifies the DTE interface operating rate when it is below that of the DDS cir
This option is only valid when the Data Rate option in the Network Options window is selecte
2.4 Kbps - Async; it is grayed out when any other rate is selected. 

Options: 

Disable 

1200 

600 

1800 to 2400 

Diagnostic Parameters

Data Set Ready – selects how the DSU controls the DSR output to the DTE during local loopb
(LL) test modes 

Options:

Off During LL Test 

Normal – DSR operates in the same way that it is optioned to function during data mode
operations 

Line Loopback Test Points – selects whether a Line Loopback command causes the DSU on
loop transmit data back to the DTE, or also to loop receive data back to the network 

Options: 

Network & DTE – Line Loopback command causes DSU to loop data in both directions

DTE Only – Line Loopback command causes DSU to loop data back to DTE only 
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Alarms Reported

The NMS 510 Alarms Reported configuration window (Figure 7-8) lets you configure which alarm
conditions are to be reported for the DSU and which are not. The window contains three pa
labeled Network, DTE, and Unit as shown below. 

Figure 7-8 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection
located to its left. You can select or de-select individual alarm options by simply clicking the m
button on the appropriate selection fields. When an option is selected for its alarm to be rep
its selection field is highlighted. The selection fields next to alarm options that are not to be rep
are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option fie
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection fields. 

After clicking Report All or Report None you can then change the state of individual fields as
needed. 
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Alarms Reported Buttons

Report All  – unmasks all alarms.

Report None – masks all alarms.

Reset – replaces the information in the fields with the most recently read information from the D 
Note that this button does not initiate a read of information from the DSU.

OK  – saves your changes and closes the window.

Cancel – cancels your changes and closes the window.

Network

Frame Loss is the one Network alarm. When it is unmasked you must specify a threshold fo
evaluating the alarm condition. 

Alarm Interval  - determines the time span for threshold evaluation. 

Options:

1 min, 5 min, 10 min, 15 min 

Frame Loss - lets you mask or unmask Frame Loss alarms. The alarm occurs when the num
lost frames in the received signal during one Alarm Interval exceeds the selected threshold.

Options:

1, 2, 5, 10, 20, 40, 60, 80, 99 

DTE

DTP Loss – alarm indicating loss of Data Terminal Power

DCD Loss – alarm indicating loss of Data Carrier Detect

DSR Loss – alarm indicating loss of Data Set Ready 

DTR Loss – alarm indicating loss of Data Terminal Ready

RXD Loss – alarm indicating no receive data from the remote DSU 

TXD Loss – alarm indicating no transmit data from the DTE 

Streaming – alarm indicating a streaming condition at the DTE interface 

Unit

No Signal – alarm indicating there is no signal at the DSU network interface 

STC Loopback – alarm indicating the DSU has been commanded into a test mode by the Tel
Serving Test Center (STC) 

Front Panel Test – alarm indicating the DSU has been commanded into a test mode by means
front panel switches

EEPROM Checksum – Configuration Checksum error alarm
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Configuration Functions – Maintenance
You can launch the NMS 510 Maintenance function from the Element submap Configuration 
or from the front panel menu. The application displays one read/write window by which you 
control some aspects of DSU operation that fall outside the scope of Configuration. See Figure 7-9. 

The window title bar displays the function name, NMS 510 Maintenance. The Name field dis
the shelf name and the slot number of the master DSE followed by the slot:line:drop address
DSU. The File menu contains only the selection Exit, by which you can dismiss the window.

Maintenance Window Buttons

The Maintenance window provides the following three buttons. 

Front Panel – permits you to enable or disable the hardware test switches on the front panel 
DSU. The label on the button appears as either Inhibit Front Panel or Enable Front Panel, a
toggles between the two displays each time you click on the button. The button displays Inh
Front Panel when the switches are enabled, and it displays Enable Front Panel when they a
disabled. 

Reset to Factory Defaults – causes all options in the DSU to return to their factory default settin
When you click on this button the application displays a warning “Resetting to factory defaults
terminate communications to the unit. Do you want to continue?” Click on the OK button in t
warning window to complete the reset, or click on the Cancel button to cancel the reset. 

Soft Reset – causes the DSU to perform a reset and resume operation using its current 
configuration. When you click on this button the application displays a warning “Performing a
reset will disrupt communications to the unit. Do you want to continue?” Click on the OK butto
the warning window to complete the reset, or click on the Cancel button to cancel the reset.

Figure 7-9 Maintenance Window
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Diagnostics

You can launch the NMS 510 Diagnostics function from the Element submap Fault menu or
the front panel menu. 

The application displays one read/write window by which you can control a variety of test func
on the DSU. 

Diagnostics Window

Beneath the menu bar and the Name field the Diagnostics window (See Figure 7-10) is divided into 
three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and stopping
functions

• Graphic panel – depicts the path followed by test data during the current test 

• Time and results panel – contains an input field for specifying the duration of a test that em
the DSU test pattern generator; displays Time Remaining and Test Results 

The Diagnostics window menu bar contains File and Navigate. The File menu has only the 
selection by which you dismiss the window. The Navigate menu also has a single selection: H
by which you can access a display of test results (see Figure 7-11) accumulated during the curren
diagnostic session. 

Tests

The Diagnostics window selection panel lists three Tests to choose from, and two Patterns y
select for those tests that employ the DSU test pattern generator. The panel also includes a
field for the User Defined test pattern, and two buttons: Start Test and Stop Test. 

The following Tests are available: 

Line Loop (performed only with test pattern) 

End To End (performed only with test pattern) 

Dataloop (can be performed with or without test pattern) 

Delay Test 

The Patterns are: 

511 bit 

2047 bit 

15 bit 

Each Test and Pattern is accompanied by a check box on which you can click to select it. The 
check boxes are grayed out when the selected Test cannot be combined with an internal test
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Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the DSU. 

1. Click on the check box next to the selected test. If you are running the Delay Test, go to S

2. Under the Pattern heading, click on your selected pattern. The Dataloop test also suppo
selection None (for external data). 

3. If you are using an internally generated test pattern select, in the Test Time field, how lon
test is to run before ending automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the data 
employed by the test. If you are using an internally generated test pattern, the Time Rem
field counts down from 100 to 0 percent. 

During a test that employs an internally generated test pattern the Test Results field displa
number of errors detected; it displays In Loop when external data is in use. 

5. If you are using an internally generated test pattern, the test ends automatically at the e
the specified Test Time. For any other test, click on the Stop Test button to end the proc
The Stop Test button can also stop a test with test pattern prior to the Test Time limit tha
would end it automatically. 

Figure 7-10 NMS 510 Diagnostics Window
058R727-V400 TEAM 5520 for HP OpenView/Unix, Version 4.0.0 7-19
Issue 1 Operation Manual



NMS 510 Diagnostics

istory 

d 

attern

p 
st 
Diagnostics Table

The table below briefly describes the available tests. 

Diagnostics History

You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window (see Figure 7-11). 

Figure 7-11 Diagnostics History

The Diagnostics History window displays information in five columns:

Start Time – date and time test began 

Test – name of the test 

Pattern – test pattern used for the test; N/A when internally generated pattern is not use

Test Blocks – number of data blocks sent during the test, applies only to tests with test p

Test Results – “Idle: n/n Bit/Block Errors” for a completed test with test pattern; “Not in loo
[STOPPED]” for a completed loop test without test pattern; “TEST STOPPED” for any te
with test pattern that was ended by the Stop Test button; “n ms.” for Delay Test

Test Description

Line Loop 
(with Pattern)

DSU initiates a loopback at its network interface and activates its test 
pattern generator/checker

End To End 
(with Pattern)

DSU activates its test pattern generator/checker and transmits the 
pattern on its link to the DSE. DSU checks for errors in the signal it 
receives, which is generated by the DSE. 

Dataloop 
(without 
Pattern)

DSE transmits a command on the link that causes the DSU to loop 
data back to the DSE; DTE or external test equipment at the DSE is 
responsible for generating and checking a test pattern. 

Dataloop
(with Pattern)

DSE transmits the loopback command to the DSU, and activates its 
test pattern generator/checker to transmit the pattern and check for 
errors in the signal it receives back. 

Delay Test DSU transmits and receives a test signal, which is looped back by the 
DSE; the DSU measures the round trip time (delay). 
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To close the Diagnostics History window, click on either the OK button or the pushpin icon in
upper left corner of the window. During an on-going diagnostic session you can close and re
the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics window. 

Miscellaneous Functions

Front Panel Poll Rate

You can open the Front Panel Poll Rate window (See Figure 7-12) from the Shelf Map Misc Menu. 
The setting you select in this window determines the initial polling rate for Front Panel displa
each time they are opened. 

The rate selection is a global function. It selects initial polling rate for all front panel displays lin
to a TEAM Core application, regardless of which individual application you access it from. 

There are four selections, each accompanied by a checkbox: 

Slow 

Normal 

Fast 

Demand Poll Only 

The File menu in the menu bar contains two selections: Save to File and Exit. 

To set the desired polling rate, first click on the appropriate checkbox and then select Save 
from the File menu. The precise polling frequency that results from a setting of Slow, Norma
Fast depends on a number of factors. The higher the rate, the more communication and pro
capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a se
by means of the Auto Poll selection in the Select button menu. Changes you make with that
selection are not retained when the display is closed. 

To dismiss the window, select Exit from the File menu. 

Figure 7-12 Front Panel Poll Rate Window
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Note Pad

You can launch the Note Pad application from the Shelf Map Misc Menu. The application op
shell tool on the workstation running the TEAM software. You can use the shell tool to run a
editor, mail tool, or any other software that resides on the workstation. The Note Pad applic
provides this access for keeping records on the system. 
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